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	Methods of Communication� Unit 1: Communication Skills-II

ACTIVITY Page 21
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A. 	 1. 	 iv.			   2. 	i.
B. 	 1.	 True			   2. 	False

Section B (Subjective Type Questions)
A.	 1.	 The agenda of business meetings includes different aspects such as planning out business 

strategies, management updates or organizational decisions.
	 2.	 Two important elements of communication process include:
	 	 •	 �Transmitting: It refers to the process in which the sender transmits the message through 

one medium or another.
	 	 •	 Listening: It refers to the process in which listener receives or understands the message.
B.	 Notices/Posters

	Verbal Communication� Unit 1: Communication Skills-II

Unsolved Exercise 
Section A (Objective Type Questions)

A.	 1.	 ii	 2.	 i	 3.	 ii
B.	 1.	 Public Communication	 2.	 nervous

Section B (Subjective Type Questions)
A.	 1.	 Following are the disadvantages of verbal communication:
	 	 •	 It does not provide a written record, making it difficult to refer back the details later.
	 	 •	 Detailed discussions can be time consuming.

1.

2.

Part-A: Employability Skills
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	 2.	 Clarity can be ensured during information sharing by speaking audibly as well as at a moderate 
pace along with avoiding repetition of sentences.

B.	 The type of verbal communication used is public communication.
	 The leader can enhance communication by:
	 •	 Using clear and powerful language.
	 •	 Speaking confidently and with appropriate body language.
	 •	 Engaging the audience with rhetorical questions or repetition.

	Non-Verbal Communication� Unit 1: Communication Skills-II

ACTIVITY Page 28
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A.	 1.	 ii		  2.	 ii	 3.	 iv
B.	 1.	 Touch	 2.	 Non-Verbal

Section B (Subjective Type Questions)
A.	 1.	 Touch creates a sense of connection, provide comfort and express feelings more effectively 

than words.
	 2.	 Eye contact shows attentiveness, builds trust, and helps convey sincerity. It also indicates 

interest and engagement in a conversation.
B.	 Bhupesh should make direct eye contact, maintain a respectful posture, and speak clearly. These 

non-verbal cues will help him get and keep the teacher’s attention.

	�Communication Cycle and Importance  
of Feedback� Unit 1: Communication Skills-II

Unsolved Exercise 
Section A (Objective Type Questions)

A.	 1.	 iv			   2.	 i
B.	 1.	 Descriptive			   2.	 detailed, specific

Section B (Subjective Type Questions)
A.	 1.	 Feedback is considered as the backbone of communication as it ensures that the message 

has been comprehended by the receiver, it enables to remain focused on goals and it enables 
to take better decisions to improve and increase performance.

3.

4.
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	 2.	 Following are the qualities of good feedback:
	 	 •	 Feedback should be specific.
	 	 •	 Feedback should be received on time.
	 	 •	 Feedback given should be polite.
	 	 •	 Feedback sharing needs to be a regular process.
B.	 The part of the communication cycle happening is Decoding. Amisha is converting the encoded 

message (in the form of text) into an understandable language.

	Barriers to Effective Communication
� Unit 1: Communication Skills-II

ACTIVITY Page 36
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iii	 2.	 ii	 3.	 iii
B.	 1.	 Language Barriers	 2.	 concise

Section B (Subjective Type Questions)
A.	 1.	 Noise is an undesirable input due to which communication barriers enter the communication 

process and cause distortion of the message.
	 2.	 Correct communication should convey right things without misleading the audience.
B.	 �Linguistic barrier, Rahul can make the explanation more effective by using simple words and 

avoiding jargons.

	Writing Skills—Parts of Speech� Unit 1: Communication Skills-II

ACTIVITY Page 40
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 i			   2.	 i
B.	 1.	 Conjunction			   2.	 Adjective

5.

6.
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Section B (Subjective Type Questions)
A.	 1.	 Articles help make general things specific by defining whether a noun is referring to something 

specific or general. For example, "I saw a dog in the park" (general, any dog) vs "I saw the dog 
in the park" (specific, referring to a particular dog known to both the speaker and listener).

	 2.	 The exclamation mark is used to express strong emotions or emphasize an exclamation. For 
example, "What a beautiful sunset!"

B.	 "Quickly" is an adverb. It modifies the verb "finished" by describing how the action was performed.

	Writing Skills—Sentences� Unit 1: Communication Skills-II

ACTIVITY Page 45
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 i		  2.	 i
B.	 1.	 supporting	 2.	 paragraph

Section B (Subjective Type Questions)

A.	 1.	 i.	 Exclamatory	 	 ii.	 Imperative	 iii.	 Interrogative
	 2.	 There are four elements in a paragraph named as Unity, Order, Coherence and Completeness.

B.	 �My favourite cuisine is South Indian cuisine.
	 South Indian cuisine
	 �It is known for its rich flavours, aromatic spices and diverse variety of vegetarian and non-

vegetarian dishes. This cuisine primarily originates from the states of Tamil Nadu, Kerala, 
Karnataka, Andhra Pradesh, and Telangana, each offering unique culinary traditions. Most 
of the typical South Indian meal is centered around rice, generally paired with flavourful curries, 
tangy chutneys, and crispy dosas or soft idlis. Coconut, tamarind, curry leaves, mustard seeds, 
and dried red chillies are the staple ingredients, adding a unique taste to the food. Items like 
sambar, rasam are common across the region, while delicacies such as Hyderabad biryani, 
Chettinad curry, and Kerala’s appam with stew showcase regional specialties.

	� The cuisine has a strong emphasis on fermented foods, which not only enhance flavour but also 
improve digestion and nutrition. Breakfast dishes like idli, dosa, and upma are light yet filling, 
while meals often include an assortment of vegetable curries, lentils, and pickles served on 
banana leaves for an authentic experience. South Indian sweets like Mysore pak, payasam add 
a perfect balance of sweetness to the otherwise spicy and tangy flavours. With its balance of 
health, taste, and tradition, South Indian cuisine continues to be celebrated both in India and 
across the globe.

7.
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	Stress Management� Unit 2: Self-Management Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iii	 2.	 ii	 3.	 iii
B.	 1.	 anxiety	 2.	 Negative	 3.	 mental
C.	 1.	 True	 2.	 False	 3.	 False

Section B (Subjective Type Questions)
A.	 1.	 ABC of stress management includes:
	 	 •	 Adversity: Be aware of the adversities or stressful events that is causing stress.
	 	 •	 Beliefs: Trust the way you handle and deal a situation.
	 	 •	 �Consequences: Know the outcomes of the events and use stress management tools to 

overcome them.
	 2.	 Physical symptoms: Breathlessness, dry mouth, sweaty palms, etc.
		  Mental symptoms: Irritation, impatience, anxiety, depression, etc.
	 3.	 �Emotional intelligence is the skill of understanding, using and managing emotions effectively. 

It involves being aware of your emotions, using them to think and solve problems effectively 
and regulating emotions to maintain emotional balance.

	 4.	 The following are the agents that can cause stress:
	 	 •	 �Mental: Students often experience mental stress when they struggle with their studies 

or face high self-expectations, leading to anxiety and pressure.
	 	 •	 �Physical: Adolescents may face physical stress due to increased self-consciousness about 

their appearance and the challenges associated with hormonal changes.
	 	 •	 �Social: This type of stress occurs due to peer pressure, family discords, status show  

off etc.
	 	 •	 �Financial: Young individuals may experience stress when they seek financial independence, 

which can lead to pressures related to managing money and achieving financial stability.
	 5.	 �Few stress management techniques include Nature walks, Time management, Academic        

planning, etc. but the most effective one is the academic planning as it enables one to 
complete project on time.

B.	 �To manage stress, Aisha can prioritise tasks, practise deep breathing, take short breaks, talk to 
someone, and engage in relaxing hobbies like music or painting.

1.
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	�Self-Awareness—Strength and Weakness 
Analysis� Unit 2: Self-Management Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iii	 2.	 ii	 3.	 ii
B.	 1.	 True	 2.	 False	 3.	 False

Section B (Subjective Type Questions)
A.	 1.	 Interests Abilities

Interests refer to activities, subjects that 
attract or engage our attention and 
curiosity.

Abilities refer to the innate or acquired skills 
that enable to perform tasks effectively.

Interests can cover a wide range of areas 
from hobbies and leisure activities to 
academic subjects or professional fields.

Abilities are specific to certain tasks or 
domains such as analytical abilities, artistic 
skills or physical coordination.

Interests can change and evolve based on 
experiences, exposure and personal growth.

Abilities are relatively stable over time 
and less likely to change as compared to 
interests, although they can be enhanced 
or refined with effort.

	 2.	 Here are some examples of strengths: 
	 	 •	 Creativity: Coming up with innovative ideas and solutions.
	 	 •	 Communication: Expressing ideas clearly and listening attentively.
	 	 •	 Organisation: Planning and managing tasks effectively.
B.	 �Shalini can start by reflecting on her current habits to identify what causes disorganisation. By 

acknowledging this weakness, she can set small goals like creating daily task lists, using planners 
or apps, and seeking feedback on her progress. This self-awareness will help her adopt better 
habits and become more organised over time.

	Self-Motivation� Unit 2: Self-Management Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 ii	 2.	 iv
B.	 1.	 False	 2.	 True

2.

3.
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Section B (Subjective Type Questions)
A.	 1.	 Self-motivation is the inner drive that pushes us to take action and pursue our goals, regardless 

of external influences. For example, suppose you want to learn any instrument/sports of your 
choice then even if no one tells you to practice, you practice it every day because you want 
to get better at playing.

	 2.	 Following are the qualities of self-motivated people:
	 	 •	 Resilient: They bounce back from setbacks and failures, using them as learning 

opportunities rather than letting them derail their progress.
	 	 •	 Proactive: They take initiative and are proactive in pursuing their goals, rather than 

waiting for opportunities to come to them.
	 	 •	 Adaptable: They are flexible and adaptable to changes and challenges, adjusting their 

approach as needed to continue moving forward.
B.	 �Key skills and strategies to be emphasized are:
	 •	 Find out the strengths by identifying likes, dislikes, etc.
	 •	 Set and focus on goals by fixing your targets and using all energy to achieve them.
	 •	 Develop a plan by planning and setting time line to meet your goals.
	 •	 Stay loyal to your goals by continuing work in difficult times or stress.

	Self-Regulation—Goal Setting�Unit 2: Self-Management Skills-II

ACTIVITY Page 66
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 ii	 2.	 ii
B.	 1.	 True	 2.	 True

Section B (Subjective Type Questions)
A.	 1.	 SMART stands for Specific Measurable Achievable Realistic Time-bound.
	 2.	� Goals should be realistic and attainable, aligning with your abilities, resources, and 

circumstances. For example, spending two hours every day after school to revise for exams 
is more achievable than attempting to revise an entire year’s syllabus in one day.

B.	 �Aditi can set a SMART goal by saving `1000 every month for 5 months. This is specific  
(buying a bicycle), measurable (`5000 needed), achievable and realistic based on her savings, 
and time-bound with a 5-month deadline.

4.
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	Self-Regulation—Time Management
� Unit 2: Self-Management Skills-II

ACTIVITY Page 70
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iii	 2.	 ii
B.	 1.	 False	 2.	 False

Section B (Subjective Type Questions)
A.	 1.	 Regular breaks help refresh the mind, reduce fatigue, and improve concentration and 

productivity.
	 2.	 �We can use technology tools like Calendar, reminders and task management apps to schedule 

activities and deadlines.
B.	 �Pankaj can avoid distractions by using a study schedule, setting fixed time slots for revision, 

turning off social media notifications, and using apps like timers or planners to stay focused 
and manage time effectively before his exam.

	Basic Computer Operations
� Unit 3: ICT Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 i	 2.	 iii	 3.	 ii	 4.	 ii
B.	 1.	 hardware	 2.	 Operating System 	 3.	 Basic Input/Output System	 4.	 Single-user
C.	 1.	 True	 2.	 True	 3.	 False	 4.	 True

Section B (Subjective Type Questions)
A.	 1.	 The operating system performs the following functions in a device: 
	 	 •	 �Device Management: OS directly controls the operation of the input-output devices, 

like controlling the action of the printer, or the CD-ROM drive.
	 	 •	 Memory Management: OS co-ordinates and controls the use of memory in a computer. 
	 	 •	 File Management: Helps organise, find, and protect files on the computer.
	 	 •	 �User Interface: Provides a way for users to interact with the computer and its programs 

easily.

5.

1.
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	 2.	� ICT refers to the wide range of tools and technologies that enable us to gather, store, process 
and share information electronically. These technologies include computers, smartphones, 
the internet, software applications and digital platforms.

	 3.	� The operating system is crucial for computers as it acts as a mediator between the hardware, 
software, and users. This interface can be graphical, such as the desktop environment, or 
command-line-based, where users enter text commands to execute tasks. One of the primary 
functions of the operating system is to establish standards for how application programs 
interact with the computer’s hardware.

	 4.	 �We can prevent others from using our computer by setting a strong password, locking the 
screen when not in use, enabling security settings and antivirus, and disabling guest access.

	 5.	 i.	� Desktop: It is the graphical screen containing icons and pictures that gets displayed 
when a user logs on to a graphical operating system.

	 	 ii.	 �Icons: These are the buttons on the desktop in the form of small pictures with some text 
written below them.

B.	 �BIOS might not be working properly.

	Performing Basic File Operations
� Unit 3: ICT Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 i	 2.	 iii	 3.	 i
B.	 1.	 directories			   2.	 orderliness
C.	 1.	 True	 2.	 False	 3.	 False

Section B (Subjective Type Questions)
A.	 1.	 Folders are virtual containers that enable to categorise and store related files in a structured 

manner. A folder can contain files as well as folders within itself.
	 2.	 �Steps to create a file are:
		�  Step 1:	 Navigate the location, in which you want to create a file.
		  Step 2:	 Right click on the empty area.
		  Step 3:	 Select the ‘New’ option 
		  Step 4:	 Select the desired type of file that you want to create.
		  Step 5:	 Type the desired file name of the file.
	 3.	 Steps to move a file are:
		  Step 1:	 Right click on the file that has to be moved and then select ‘Cut’ option.
		  Step 2:	 Right click on the desired location and then select ‘Paste’ option from the context 

menu.

2.
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	 4.	 Steps to copy a file are:
		  Step 1:	 Right click on the file that has to be copied and then select ‘Copy’ option.
		  Step 2:	 Right click on the desired location and then select ‘Paste’ option from the context 

menu.
B.	� The file system will help Riya organise her documents, images, and videos by allowing her to 

create separate folders for each category or project. This structure will make it easier to locate 
files quickly, avoid clutter, and ensure better file management. It also protects her data by 
keeping related files grouped and reducing the risk of accidental deletion.

	Computer Care and Maintenance
� Unit 3: ICT Skills-II

Lab Assignment ‘n Activity Page 94

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iv	 2.	 ii	 3.	 iii
B.	 1.	 organised	 2.	 temperature
C.	 1.	 True	 2.	 False

Section B (Subjective Type Questions)
A.	 1.	 Taking regular backup of your computer data is crucial because it protects against any 

kind of data loss due to hardware failures, malware attacks, accidental deletions, or system 
crashes. Backup ensures that important files, documents, and settings can be restored quickly, 
minimising loss and act as an alternative source for easy accessibility.

	 2.	 �The purpose of using antivirus software is to prevent attack of viruses in your system as well 
as it scans and removes viruses that have already sneaked in your system to keep it safe.

	 3.	 �Computer’s performance can be increased by regular cleaning of the unnecessary files using 
disk cleaner software. Regularly delete the unnecessary files present in the hard drive to free 
up the space.

	 4.	 Following actions should be done on a monthly basis:
	 	 •	 Take backup of the data present in the hard drive.
	 	 •	 Uninstall most rarely used software.
	 	 •	 Installed software must be updated regularly.
	 	 •	 To avoid disk errors, delete temporary internet files.
	 	 •	 Change passwords frequently.

3.
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B.	 �If you receive an email with a suspicious attachment from an unknown sender, do not open the 
attachment. Instead, delete the email immediately or mark it as spam. Run a full system scan 
using updated antivirus software and avoid downloading anything from untrusted sources.

	Computer Security and Privacy
� Unit 3: ICT Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 ii	 2.	 ii	 3.	 iii	 4.	 iv	 5.	 iii
B.	 1.	 Master Boot Record (MBR)	 2.	 executable	 3.	 spammer	 4.	 Sunday and Cascade
C.	 1.	 False	 2.	 True

Section B (Subjective Type Questions)
A.	 1.	 A Trojan horse is a type of malicious software or malware that disguises itself i.e., appears to 

be a useful software program but once it reaches a computer, it starts behaving like a virus 
and destroying data. They are activated when the user is busy interacting with entertaining 
programs or with interface like computer games. Some examples of Trojan are Linux, Wifatch, 
Infostealer, Kronbank, etc.

	 2.	� Following are the ways to protect data:
	 	 •	 Update the Antivirus.
	 	 •	 Use Passwords to login to your computer.
	 	 •	 Data should be encrypted to prevent unauthorised usage.
	 	 •	 Use secured websites for browsing or any kind of transaction.
	 3.	 �Cookies contain information about your visit to the web page, or record your login information. 

Cookies can enhance your browsing experience by remembering your preferences and 
streamlining online tasks.

	 4.	 �Encrypt data refers to the encryption of confidential data to prevent unauthorised usage. It 
requires usage of decryption password to decode it.

	 5.	 Following are the steps to remove files of a temporary folder.
		  Step 1:	 Press ‘Windows+R’ key on the keyboard. Run dialog box appears on the screen.
		  Step 2:	 Type ‘%temp%’ in the Open box.
		  Step 3:	 Click on ‘OK’ button. Temp folder appears on the screen.
		  Step 4:	 Press ‘Ctrl+A’ to select all the files and folder in the Temp folder.
		  Step 5:	 Press ‘Shift+Delete’ to permanently delete the files.
		  Step 6:	 Click on ‘Yes’ button.
B.	� AVG antivirus

4.
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	Entrepreneurship and Society
� Unit 4: Entrepreneurial Skills-II

ACTIVITY Page 113
Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iii	 2.	 i
B.	 1.	 customer	 2.	 supply chains			  3.	 Woman entrepreneurship
C.	 1.	 True	 2.	 True

Section B (Subjective Type Questions)
A.	 1.	 Entrepreneurs have a great impact on our society in various forms:
	 	 •	 �Create jobs- They identify the opportunities in the market and take risk to capitalize on 

them and generate opportunities across various sectors.
	 	 •	 �Sharing of wealth- Successful entrepreneurs contribute significantly to wealth distribution 

through various channels such as they pay taxes on the profits earned as well as personal 
income. They donate a substantial amount of money for various charitable causes, 
educational institutions, etc.

	 	 •	 �Lower price of products- Entrepreneurs drive down the prices of goods and services 
through competition and innovation. They compel existing businesses to improve 
efficiency, reduce cost and offer better value to consumers by introducing new products 
in the market.

	 2.	 �Entrepreneurs satisfy customers' needs, wants, and demands by recognising them and taking 
appropriate measures. This can be understood as follows:

		  •	 �Needs: An entrepreneur ensures its product or service is essential to the target market. 
Meeting these needs is crucial for initial market entry and survival, such as offering 
essential healthcare products or staple foods.

		  •	 �Wants: These are opportunities for an entrepreneur to differentiate and add value to 
the basic offerings by aligning products with consumer desires and preferences.

		  •	 �Demands: It represent the potential market size when consumers are not only interested in 
a product but also have the financial capability and readiness to purchase it. Entrepreneur 
successfully taps into demands means identifies and targets segments with the highest 
purchasing power and interest in the product.

	 3.	 Following are the key tasks performed by the entrepreneur:
	 	 •	 �Entrepreneurs meet customer needs by offering products or services that ease their 

lives, solve specific problems or fulfill desires ensuring quality and reliability to satisfy 
expectations.

1.
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	 	 •	 �Entrepreneurs support use of local materials to support local economies, reduce 
environmental impact through shorter supply chain.

	 	 •	 �Entrepreneurs contribute to society by creating jobs, improving living standards through 
innovative products or services and supporting community initiative to promote social 
development and wellbeing.

	 4.	 �Agriculture entrepreneurship is a kind of entrepreneurship which focuses on marketing and 
producing agricultural inputs and products, benefiting farmers with innovative and cost-
effective farming techniques.

B.	 �Social Entrepreneurship.

	Qualities and Functions of an Entrepreneur
� Unit 4: Entrepreneurial Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 i	 2.	 i	 3.	 ii
B.	 1.	 True	 2.	 False

Section B (Subjective Type Questions)
A.	 1.	 The most important function of an entrepreneur can be regarded as innovation of new ideas, 

products or methods that can be introduced in the market which can meet market demands 
as well as bring progress in the development process.

	 2.	� The two basic roles of an entrepreneur are as follows:
	 	 •	 �They act as a job creator as they provide employability to a large number of people. They 

establish a business entity by investing their own resources as well as taking capital from 
investors as well as public.

	 	 •	 �Entrepreneur set up new businesses and industrial units leading to regional development 
which in turn leads to development of different infrastructures like roads, electricity, water 
supply, etc.

B.	� Dividing Income.

	Myths about Entrepreneurship
� Unit 4: Entrepreneurial Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 i	 2.	 iv
B.	 1.	 True	 2.	 True

2.

3.
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Section B (Subjective Type Questions)
A.	 1.	 Aspect Businessman Entrepreneur

Focus Manages and operates an established 
business.

Identifies and exploits new 
business opportunities.

Role Oversees day-to-day operations, 
resource management.

Involved in all aspects of 
business creation and growth.

Risk Takes calculated risks within existing 
business framework.

Embraces high levels of risk in 
pursuit of innovation.

Innovation Focuses on incremental improvements 
within the business.

Introduces novel solutions, 
technologies, or models.

Example CEO of a manufacturing company 
ensuring profitability.

Elon Musk, creating SpaceX and 
Tesla, pushing boundaries.

	 2.	 Following are the two common myths related to entrepreneurship:
	 	 •	 You needs a lot of money to start a business.
	 	 •	 Every business idea needs to be unique or special.
B.	 �I would tell Yatin that success doesn’t need a unique idea. Many businesses succeed by offering 

better quality, service, or creativity. His T-shirt shop can stand out through design and customer 
experience.

	Entrepreneurship as a Career Option
� Unit 4: Entrepreneurial Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iii	 2.	 ii
B.	 1.	 self	 2.	 Survive
C.	 1.	 True	 2.	 False

Section B (Subjective Type Questions)
A.	 1.	 Following are the four disadvantages of entrepreneurship as a career:
	 	 •	 Financial Risk: High potential for financial loss, especially in the early stages.
	 	 •	 �Uncertainty and Stress: Constant uncertainty about business success can lead to 

significant stress.
	 	 •	 Long Hours: Often requires long working hours and personal sacrifices.
	 	 •	 Responsibility: Full responsibility for the business's success or failure.
	 2.	� Self-Employment: It refers to individuals who work for themselves rather than for an 

employer. They may operate their own businesses, freelancing, consulting, or working as 
independent contractors. A self employed person, always trying to make his/her business 
better by taking risks and trying new ideas is an entrepreneur.

4.
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		�  Wage Employment: Wage employment refers to individuals who work for an employer and 
receive regular wages or salaries in exchange for their services. They typically follow a set 
schedule and report to a supervisor or manager. The people who work for some organisation 
and get paid for that are wage employed.

	 3.	� An entrepreneurship process begins with generating an innovative idea where various 
opportunities are explored through brainstorming and identifying the needs that are not 
yet addressed.

	 	 �After that, research and planning is done through market research to understand the industry 
trends and competitors.

	 	 �After that a comprehensive plan is developed to display the business strategy, target market, 
financial projections and operational plan. It enables to convert the structured approach into 
a successful business venture.

	 	 �New venture creation includes aspects such as launching a company, taking a franchise, 
starting a new venture in a family business or commercializing a technology.

	 Let’s understand the process of entrepreneurship with the help of an example:
	 �Ashima, a MBA graduate once went to a village for some kind of field visit found that many 

people in her village are good at making earthen cookwares. She undertook a market research 
and found that demand for earthen cookwares is in demand for the health benefits as well as for 
its eco-friendly nature.  She started planning and arranging for financial resources. She started 
selecting people who are good at this art of making earthen pots. Then started advertising about 
her startup through different portals such as social media posts, ads and hoardings of her new 
venture. This illustrates how entrepreneurship involves turning an idea into a successful business 
through planning, execution, and adaptation.

B.	 1.	 �I would explain that every successful entrepreneur takes calculated risks. With proper 
planning and support, the risk becomes manageable. I would encourage him to start small, 
gain confidence, and remind him that success often comes to those who take bold steps.

	 2.	 �I would advise Vedika to explore funding options like government schemes, startup incubators, 
or loans. If she's still unsure, she can take up a job to gain experience and save money while 
planning her startup on the side. This way, she can balance both stability and her dream.

	Sustainable Development
� Unit 5: Green Skills-II

ACTIVITY Page 130

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 iii	 2.	 i	 3.	 iii	 4.	 iv

1.
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B.	 1.	 global warming, climate change	 2.	 conservation, sustainable
	 3.	 Deforestation					    4.	 Reusing
C.	 1.	 True	 2.	 False	 3.	 True	 4.	 False

Section B (Subjective Type Questions)
A.	 1.	 Sustainable development is a kind of development that meets the needs of the present 

world without finishing off or depleting the natural resources and saving and protecting the 
resources for future generation to meet the futuristic needs.

	 2.	� Following are the two basic problems related with sustainable development:
	 	� Water: The quality of fresh water supplies has been seriously harmed by pollution from 

industrial, agricultural and residential resources. Untreated sewage, chemicals are major 
causes of water pollution making water unfit for drinking or any other usage.

	 	� Food: The amount of fertile land to cultivate crops like wheat and rice has drastically reduced 
due to utilization of land for other uses.

	 3.	� Renewable: Solar energy, wind energy, water (hydropower), biomass
	 	 Non-renewable: Coal, petroleum, natural gas, uranium
	 4.	� The 17 sustainable development goals were formulated to address issues related to 

businesses, governments and society. They also address other issues such as Poverty, Gender 
Equality, Climate change, etc. The sustainable development goals serve as a global call to 
action urging each of us to take responsibility and contribute towards a positive change.

B.	 The issue being addressed is Sustainable Goal 13: Climate Action.
	� This goal ensures immediate action to fight against climatic changes and emissions. It also leads 

to reduction in Greenhouse gas emissions, promoting climate education and awareness.

	Our Role in Sustainable Development
� Unit 5: Green Skills-II

Unsolved Exercise 
Section A (Objective Type Questions) 

A.	 1.	 ii	 2.	 iv	 3.	 ii	 4.	 iii
B.	 1.	 International Solar Alliance (ISA)	 2.	 Science, Technology, Engineering, and Mathematics
	 3.	 hot water	 4.	 legal
C.	 1.	 True	 2.	 False

2.
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Section B (Subjective Type Questions)
A.	 1.	 Government has taken few initiatives to overcome the problem of sustainable development:
	 	 •	 �Mid-Day meal scheme to address the problem of zero hunger by providing wholesome 

meal to the students to enhance their nutritional status and promoting consistent 
attendance and retention in school.

	 	 •	 �Ayushman Bharat program to offer health insurance coverage to over 10 crore families 
at a maximum cost of Rs. 5 lakh per family annually.

	 	 •	 �Ujjwala yojana was introduced to achieve the goal of lowering the health risks associated 
with using firewood and dung cakes by providing LPG connections to women from below 
poverty line.

	 	 •	 �Beti Bachao Beti Padhao Yojna to address the issue of decreasing child sex ratio and 
to support girls’ education and empowerment.

	 2.	 �Education is crucial for sustainable development because it provides an individual the 
knowledge, skills, and values needed to address environmental, social, and economic issues. 
It promotes critical thinking, innovation, and responsible decision-making, enabling people to 
adopt sustainable practices in their everyday life. Education also promotes awareness related 
to climatic changes, resource conservation, and social equity, empowering communities to 
take action for a more sustainable future.

	 3.	� A sustainable process is a way of doing things that meets our needs today without harming 
the environment or depleting natural resources for future generations. It is about using the 
resources wisely, reducing waste and thinking about how the actions are going to affect the 
planet in the long run.

	 4.	 �The government’s initiative related to goal 9 is Atal Innovation Mission (AIM) encourages 
entrepreneurship and innovation nationwide. This initiative attempts to establish an 
atmosphere that stimulates entrepreneurial thought and creativity. This project offers 
resources and support to assist small and medium sized businesses to expand and prosper.

B.	 �Lila’s initiative contributes to SDG Goal 1 – No Poverty by creating economic opportunities in 
her village. Through her craft business, she not only supports herself but also empowers other 
women by providing training and materials. This improves income levels, enhances skills, and 
leads to a better standard of living for the community.
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Part-B: Subject Specific Skills

	Introduction to Styles�
Unit 1: Digital Documentation (Advanced) Using Libreoffice Writer

Lab Assignment ‘n Activity Page 152-156

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A. 	 1.	 ii	 2.	 i	 3.	 iii	 4.	 iii	 5.	 i
B. 	 1.	 Enter	 2.	 template	 3.	 right side	 4.	 select	 5.	 Esc
C. 	 i.	 Both A and R are true and R is the correct explanation of A.
D. 	 i.	 Statement 1 is true , Statement 2 is true

Section B (Subjective Type Questions)
A. 	 1.	 Fill Format mode is used to quickly apply the selected style from Styles deck to different 

locations in the document without having to go back to the Styles deck each time.
	 2.	 Following are the steps to access Styles deck:
		  Step 1:	 Click on the Style Menu from the Menu bar.
		  Step 2:	 Select the Manage styles option.
	 	 The Styles deck will appear on the right side of the screen.
	 3.	 To apply style using the Fill Format Mode:
		  Step 1:	 Click on the Styles icon present on the sidebar, Styles deck appear on the screen.
		  Step 2:	 Click on the paragraph styles button, a list of stored paragraph  styles appears.
		  Step 3:	 Click on required style from the list.
		  Step 4:	 �Click on the Fill format mode button. The mouse pointer changes into a paint 

bucket icon.
		  Step 5:	� Hover the Fill format mode tool over the paragraph where you want to apply the  

selected style and click on.
	 	 Selected style gets applied on the paragraph.

1.



19Touchpad IT-402 (Ver. 4.0)-X (Answer Key)

	 4.	 If we apply and update manual formatting to a style in a document, same formatting is 
applied on the rest of the content also which is having that style.

	 5.	 On selecting the Overwrite option,  the styles being copied will replace any existing styles 
with the same name.

B. 	 List Styles

	Working with Images�
Unit 1: Digital Documentation (Advanced) Using Libreoffice Writer

Lab Assignment ‘n Activity Page 167-185

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A. 	 1.	 iv	 2.	 i	 3.	 ii	 4.	 i	 5.	 iv
B. 	 1.	 False	 2.	 False	 3.	 True	 4.	 True	 5.	 True
C. 	 1.	 ii. Both A and R are true but R is not the correct explanation of A.
	 2.	 i. Both A and R are True and R is the correct explanation of A.
D. 	 1.	 ii. Statement 1 is false , Statement 2 is false.

Section B (Subjective Type Questions)
A. 	 1.	 Following are the five properties of drawing objects:
	 	 •	 Line color: This control selects a color for the borderline of the drawing object.
	 	 •	 Line style: This drop down list helps to select the style of line around the object
	 	 •	 Line thickness: The control helps to select the thickness of the lines.
	 	 •	 �Area style/Filling: This drop down list helps to select the type of fill to be applied to the 

selected drawing object.
	 	 •	 Rotate: This icon is used to rotate the selected drawing object.
	 2.	 �We group drawing objects to make them act as a single object instead of different objects. If 

we need to move or resize several drawing objects in a document we group them. Grouping 
features allow rotation, flipping, moving or resizing several drawing objects because grouping 
of all the objects will make it act as a single object.

 	 3.	� Following are the steps to modify an image using image toolbar:
		  Step 1:	 Insert an image in a Writer document. The Image toolbar appears.
		  Step 2:	 Click on the Filter tool. A drop-down menu appears containing different icons of 

filter effects.
		  Step 3:	 Click on the desired filter effect.

2.
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	 4.	 Following are the steps to resize the drawing objects: 
		  Step 1:	 Select the image.
		  Step 2:	 Click on the Format menu and then select the Image → Properties option.
		  Step 3:	 Click on the Position and Size tab.
		  Step 4:	 Adjust the width, height, etc.
		  Step 5:	 Click on the OK button.
		  The image will be resized as per the set specifications.
 	 5.	 To Character: The image is associated with a character but is not in the text sequence. It 

moves with the paragraph but can be placed in the margin or another location.
		  As Character: The image is placed in the document light any other character and therefore 

affects the height of the text line and the line break. The image moves with the paragraph 
as we add or delete text before the paragraph.

B. 	 They can use a wrapping option as ‘In Background’. 
	 Following are the steps to apply this wrapping option:
	 Step 1:	 Type the textual content of the story.
	 Step 2:	 �Insert the image and right click on it and select the option “Wrap” and then select the 

sub option “In Background”.
	 The story will be displayed over the picture.

	Advanced Features of Writer�
Unit 1: Digital Documentation (Advanced) Using Libreoffice Writer

Lab Assignment ‘n Activity Page 192-217

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A. 	 1.	 i	 2.	 iv	 3.	 i	 4.	 i	 5. 	iii
B. 	 1.	 True	 2.	 True	 3.	 True	 4.	 True	 5.	 False
C. 	 ii.	 Both A and R are true but R is not the correct explanation of A.
D. 	 1.	 iii. Statement 1 is true , Statement 2 is false
	 2.	 i. Statement 1 is true, Statement 2 is true
	 3.	 iv. Statement 1 is false , Statement 2 is true

Section B (Subjective Type Questions)
A. 	 1.	 A template is a pre- designed document that can be used as a starting point for creating 

new documents with a consistent style and structure. Template can include predefined text, 
formatting, styles, images, and other elements that help in maintaining uniformity across 
different documents.

3.
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 	 2.	 Following are the steps for importing a template:
		  Step 1: 	Choose File → Templates → Manage Templates
		  Step 2: 	Click on the Manage → Import
		  The Select Category dialog box opens.
		  Step 3: 	Select a category from the existing categories.
		  Step 4: 	Click on the OK button. The Open dialog box appears.
		  Step 5:	 Navigate to the location where the template is saved.
		  Step 6:	 Select the template.
		  Step 7:	 Click on the Open button.
	 	 The selected template will be added to the templates of LibreOffice Writer.
 	 3.	 The Update index option enables to update the changes made in the document. It is useful 

when we add or delete text in the document and due to which and the headings are moved 
to a next page or if some changes are made in the format of headings, update index can 
be used.

 	 4.	 The different options or tabs that are present in the Type tab of the Table of contents, index 
or Bibliography dialog box are as follows:

	 	 •	 Title: It sets the title of the table of contents.
	 	 •	 Type: It allows us to select the type of Table of Contents.
	 	 •	 Protecting against manual changes: It restricts the manual changes in the TOC if selected.
	 	 •	 For: It allows us to create the TOC for a particular chapter or the entire document.
	 	 •	 Include up to level: It allows us to specify the maximum number of heading level for TOC.
	 	 •	 �Create from: It provides three different check boxes like heading, additional styles, and 

index entries.
	 5.	 The options that are present in the Entries tab of the Table of Contents, Index or 

Bibliography dialog box are as follows:
	 	 •	 N# : This option adds the heading number or list number of the entry.
	 	 •	 E : This option represents the entry text.
	 	 •	 T : This option represents a tab stop.
	 	 •	  #: This option represents the page number.
	 	 •	 LS: This option specifies the start of a hyperlink.
	 	 •	 LE: This option specifies the end of a hyperlink.
B. 	 While creating Table of Contents:
	 •	 Proper heading should be given to the chapter titles such as Heading 1 for chapter title, 

Heading 2 for the topics covered under this chapter.
	 •	 After assigning the headings, they should use the Insert menu.
	 •	 Click on the Table of Indexes option to create TOC.
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	Analyse Data using Scenarios and Goal Seek�
Unit 2: Electronic Spreadsheet (Advanced) Using Libreoffice Calc

Lab Assignment ‘n Activity Page 225-237

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A. 	 1.	 iv	 2.	 iv	 3.	 iii	 4.	 iii	 5.	 ii
B. 	 1.	 single/master spreadsheet	 	 	 2.	 Goal Seek	 3.	 Solver
	 4.	 Subtotal	 5.	 Group and outline
C. 	 1.	 True	 2.	 False	 3.	 True	 4.	 True	 5.	 False
D. 	 i.	 Both A and R are true and R is the correct explanation of A.
E. 	 iii.	 Statement 1 is true , Statement 2 is false

Section B (Subjective Type Questions)
A. 	 1.	 Followings options are present the in what-if scenarios dialog box:
	 	 •	 Name of Scenario: To assign a name can  be given.
	 	 •	 �Comment: To add details like creation date of scenario, user name, etc. can be given.
	 	 •	 Settings: To configure settings such as border colour, copy option can be activated.
	 2.	 Following setting options are available:
	 	 •	 �Display border: It is used to highlight the Scenarios with a border. The colour for the 

border is specified in the field to the right of this option. The border has a title bar 
displaying the name of the last scenario.

	 	 •	 �Copy Back: It copies the values of cells that you change into the active Scenarios. If you 
do not select this option, the scenario doesn’t change even when you change cell values.

	 	 •	 Copy entire sheet: It copies the entire sheet into an additional scenarios sheet.
	 	 •	 Prevent changes: It is used to prevent changes to the active scenarios
	 3.	 To use the multiple operations tool, we need two arrays of cells:
	 	 •	 The first array contains the original or default values and the formulas applied to them. 

The formulas must be in a range.
	 	 •	 The second array is the formula array. It is created by entering variables which are alternative 

values for one or two original values.
		  For Example: Rohit produces toys which he sells for $10 each. Each toy costs $2 to make, in 

addition to which he has fixed costs of $10,000 per year. We can calculate how much profit 
he will make in a year if he sells a particular number of toys.

4.
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	 	 Suppose Selling price is kept in cell B1, manufacturing cost in cell B2, fixed cost in cell B3.
		  Step 1:	To calculate the profit, enter the formula =B4*(B1-B2)-B3 in cell B5.
		  Step 2:	�In column D, enter expected annual sales, one below the other; for example, 500 to 

5000, in steps of 500.
		  Step 3:	�Select the range D2:E11, and thus it will select the values in column D and the empty 

cells alongside in column E.
	 	 Step 4:	Click on Data menu and select Multiple operations option.
	 	 	 The Multiple Operations dialog box appears on the screen.
	 	 	 Following options are there in the ‘Multiple Operations’ dialog box:
	 	 	 	 •	 �Formulas: It is used to enter the cell reference to the formula that is applied to 

the data range.
	 	 	 	 •	 �Row input cell: It is used to enter the reference to the first cell of the range 

arranged in rows that is part of the formula.
	 	 	 	 •	 �Column input cell: is used to enter the reference to the first cell of the range 

arranged in columns that is part of the formula.
		  Step 5:	With the cursor in the Formulas field, click on cell B5.
		  Step 6:	�Set the cursor in the Column input cell field and click on cell B4. This means that  

B4, the quantity, is the variable in the formula, which is replaced by the selected 
column values.

		  Step 7:	Click on OK to close the dialog box.
	 4.	 Let us consider an example to perform Goal Seek operation:
	 	 Imagine you are creating a mixture of 4 products, whose quantities in kg are  8, 5, 4. The 

targeted quantity of the mixture is 30. We will have to perform goal seek to determine how 
much quantity of 4th product should be taken to reach the targeted value.

		  Step 1: Enter the Quantity of all the products in different rows or columns.
		  Step 2: �Calculate the total no. of quantity of all the 3 products and put the 4th product 

quantity as 0.
		  Step 3: �Click on Tools Menu.
		  Step 4: Select the Goal Seek option.
			           The Goal seek dialog box appears.
		  Step 5: �Enter the cell No. in Formula Cell which contains the formula of total quantity.
		  Step 6: Enter the targeted value as 30.
		  Step 7: Click on the variable cell and put the cell no.of 4th product over there.
		  Step 8: Click on OK button.
		  Step 9: �Click on Yes button. The Quantity of the 4th product will be displayed to achieve 

the targeted value.
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	 5.	 Let’s continue with our previous example of 4 products and their quantity. Now to get target 
value of the product, quantities of multiple products are to be calculated.

		  Step 1: Select Formula cell. Here, it is B6 to calculate the total quantity of the product.
		  Step 2: Click on the Tools menu.
		  Step 3: Select the Solver Option.
			          The Solver dialog box appears on the screen.
		  Step 4: Put the Formula cell in the targeted cell.
		  Step 5: Select the value of the radio button and set its value to 30.
		  Step 6: Select the range of cells whose value can be modified by changing cells text field.
		  Step 7: Click on the Solver Button and give the limiting conditions.
		  Step 8: Click on the Keep Result button to keep the updated values in the cell.
B. 	 She can use the Subtotal feature.

	Using Macros in Spreadsheet�
Unit 2: Electronic Spreadsheet (Advanced) Using Libreoffice Calc

Lab Assignment ‘n Activity Page 259

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A. 	 1.	 iii	 2.	 i	 3.	 iv	 4.	 ii	 5.	 i
B. 	 1.	 underscore	 	 	 2.	 Sub	 3.	 BASIC	 4.	 values	 5.	 macro
C. 	 i.	 Both A and R are true and R is the correct explanation of A.
D. 	 iv.	 Statement 1 is false , Statement 2 is true

Section B (Subjective Type Questions)
A. 	 1.	 Steps to create a macro that work as a function and displays ‘hello world’ are as follows:
		  Step 1: Create a new spreadsheet.
		  Step 2: Go to Tools → Macros → Organize Macros → Edit Macros.
		  	 The Macro code window opens.
		  Step 3: Create an empty line before Sub and End Sub.
		  Step 4: Write the given code in the code window:
			   Function DisplayData() 
			   DisplayData()=″Hello World!!!″
		  	 End Function
		  Step 5: �Press Ctrl + S shortcut key from the keyboard or click on Save button on the  

Standard toolbar to save the changes in the code window.

5.



25Touchpad IT-402 (Ver. 4.0)-X (Answer Key)

	 2.	 While organising a macro, we have to focus on the following key points:
	 	 a.	 Break It Down:  Divide a Macro into smaller, manageable sections.
	 	 b. 	 Use clear names:  Name variables and parts of the Macro clearly for easy understanding.
		  b.	 Add comment:  Include notes in your court to explain what each part does.
	 	 c.	 Handle errors:  make sure the Macro can deal with problems without crashing.
	 	 d.	 Test regularly:  check the Macro to ensure it works as expected.

	 3.	 Follow the steps to record a macro:
		  Step 1:	 Create a new spreadsheet.
		  Step 2:	 Enter number into a spreadsheet.
		  Step 3:	 Select the cell B2.
		  Step 4:	 Press Ctrl+C key combination to copy the value to the clipboard.
		  Step 5:	 Select the range A1:B3.
		  Step 6:	 Click on the Tools menu from the Menu bar.
		  Step 7:	 Select the Macros option.
		  Step 8:	 Select the Record Macro option.
				�    The recording will start immediately. As soon as the record macro is active a dialog 

box of Stop recording will be activated.
		  Step 9:	 Select the Edit menu from the Menu bar.
		  Step 10:	 Select the Paste special → Paste Special option from the submenu.
	 	 	 	 The Paste Special dialog box opens.
		  Step 11:	 Select the Multiply radio button under Operations section.
		  Step 12:	 Click on the OK button.
				    The operations specified in macro is applied to the selected cell range(A1:B3).
		  Step 13:	 Click on the Stop Recording option.
	 	 	 	 �The BASIC Macros dialog box opens, to stop the Macro Recorder and to save the 

macro.
		  Step 14:	 �Select the current Spreadsheet. Click on the ‘+’ next to the spreadsheet to view 

the contained libraries.
		  Step 15:	 �Click on the New Module to create a module in the Standard library. If no libraries 

exist, then the Standard library is automatically created and used.
		  Step 16:	 Click on the OK button to create a module named Multiply.
		  Step 17:	 Select the newly created module Multiply.
		  Step 18:	 Type the macro name Multiply5 in the Macro Name text box.
		  Step 19:	 Click on the Save button.
	 4.	 Following are the steps to view macro:
	 	 •	 Go to Tools > Macros > Organize Macros > Basic to open the Basic Macros dialog.
	 	 •	 Select the desired macro that you want to view and click Edit.
	 	 	 The Basic IDE will open and the macro.
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	 5.	 Predefined functions Macros

Predefined functions are built-in functions 
provided by Calc, like SUM, AVERAGE, and IF.

Macros are user-defined sequences of 
actions that can perform more complex, 
customized tasks, essentially recording 
and replaying a series of steps to 
automate repetitive actions.

 Predefined functions are used to perform 
common calculations automatically in cells.

Macros are used to automate repetitive 
tasks or complex procedures.

B. 	 She can create a macro function ADD( ).
	 She can go to Tools menu → Macros → Edit Macros
	 Write the code as given below:
	 REM  *****  BASIC  *****
	
	 Sub Main
	
	 End Sub
	
	 Function add(a,b)
	 add=a+b
	 End Function
	 This function can be used in any cell and cell address can be given as arguments.

	Linking Spreadsheet Data�
Unit 2: Electronic Spreadsheet (Advanced) Using Libreoffice Calc

Lab Assignment ‘n Activity Page 272

Do it yourself.

Lab Assignment ‘n Activity Page 281

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 ii	 2.	 i	 3.	 ii	 4.	 i
B. 	 1.	 True	 2.	 False	 3.	 True	 4.	 False
C. 	 ii.	 Both A and R are true but R is not the correct explanation of A.

6.
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Section B (Subjective Type Questions)
A. 	 1.	 Relative Hyperlink Absolute Hyperlink

A Relative Hyperlink contains a partial 
address.

An Absolute Hyperlink contains a full 
address, the protocol and domain name for 
URL, and the entire path and file name for 
documents.

For Example: https://orangewebsupport.
co.in

For Example: www.orangeeducation.in/
about.html

	 2.	 Following are the steps to create a hyperlink to a sheet:
		  Step 1:	 �Select the cell in which hyperlink is to be created. Click on the Insert menu and 

select Hyperlink option. Hyperlink dialog box appears.
		  Step 2:	 Select the Document option present on the Hyperlink dialog box.
		  Step 3:	 Click on the open file button to specify the path.
		  Step 4:	 Browse the location of the target document and select the file.
		  Step 5:	 Click on the Open button.
	 3.	 Following are the steps to create reference to other sheet
		  Step 1:	 Open a new spreadsheet Untitled1 and select any cell.
		  Step 2:	 Open any existing spreadsheet.
		  Step 3:	 Go back to Untitled 1 spreadsheet and type = in any cell say A1
		  Step 4:	 Select the desired cell A2 on the existing sheet.
		  Step 5:	 A reference of the cell has been created in Untitled 1.
		  Step 6:	 Press Enter key
	 4.	 Following are the steps to edit a hyperlink:
		  Step 1:	 Hover the cursor anywhere on the link and right-click on hyperlink.
				    A pop up menu will be displayed.
		  Step 2:	 Click on the option Edit Hyperlink.
				    The Hyperlink dialog box will appear. Make desired changes in the hyperlink.
B.	 Hyperlink feature

	Share and Review a Spreadsheet�
Unit 2: Electronic Spreadsheet (Advanced) Using Libreoffice Calc

Lab Assignment ‘n Activity Page 300

Do it yourself.

7.



28 Touchpad IT-402 (Ver. 4.0)-X (Answer Key)

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 i	 2.	 ii	 3.	 ii	 4.	 ii
B. 	 1.	 False	 2.	 False	 3.	 False	 4.	 True	 5.	 True
C. 	 i.	 Both A and R are true and R is the correct explanation of A.

Section B (Subjective Type Questions)
A. 	 1.	 The purpose of sharing a spreadsheet is to allow multiple users to access, edit, and update 

the data on the same sheet simultaneously.
	 2.	 To edit and format the text of a comment we have to follow the following steps:
		  Step 1:	 �Right-click on the cell containing the comment marker and then select Show 

Comment from the popup menu.
		  Step 2:	 �Double click on the comment.  The cursor changes to the blinking text entry and 

the formatting toolbar changes to show text attributes.
		  Step 3:	 After editing,  click outside the comment to deselect it.
	 3.	 To merge different versions of a spreadsheet, follow the given steps:
		  Step 1:	 Open the original document into which you want to merge all copies.
		  Step 2:	 Click on the Edit menu.
		  Step 3:	 Click on Track changes option and then select Merge Document.
		  Step 4:	 �Select the copy of the document from the dialog box.  If there has been no subsequent 

change in the original document, the copy is merged into the original.
		  Step 5:	 �If changes have been made in the original document,  a dialog box appears asking 

to accept or reject changes.
		  After merging the documents, you can see the recorded changes from the copied document 

into the original document.
	 4.	 When a shared spreadsheet is saved, one of the several situations may occur:
	 	 •	 If the document was not modified and saved by another user, the document will be saved.
	 	 •	 �If the document was modified and saved by another user , one of the following events 

will occur:
	 	 	 ⴰ	 �If the changes do not conflict, that document is saved, a dialog box appears, and any 

cells modified by the other user are shown.
	 	 	 ⴰ	 �If the changes conflict, the Resolve conflicts window appears on the screen, decide 

for each conflict that is which version to keep, Keep Mine or Keep Other. When all 
conflicts are resolved, the document is saved. While resolving the conflicts, no other 
user can save the shared document.

	 	 	 ⴰ	 �If another user is trying to save the shared document while another user is resolved in 
conflicts, a message that the shared document is locked due to a merge in progress.  
Choose the Cancel saving or Retry saving later.

B. 	 Reviewing Changes
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	Introduction to Database Management System
� Unit 3: Database Management System Using Libreoffice Base

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 ii	 2.	 iii	 3.	 i	 4.	 iii	 5.	 i	 6.	 ii
B. 	 1.	 False	 2.	 True	 3.	 False	 4.	 True	 5.	 True	 6.	 False
	 7.	 True	 8.	 True	 9.	 False	 10.	 True
C. 	 1.	 i.  Both A and R are true and R is the correct explanation of A.
	 2.	 ii. Both A and R are true but R is not the correct explanation of A

Section B (Subjective Type Questions)
A. 	 1.	 A database is defined as an organised collection of data that can be visualised as a container 

of information. It allows for the storage, modification and retrieval of data efficiently.
	 2.	 When the data is stored in multiple tables that are linked to each other on the basis of a 

common field, then such a database is called a Relational database, and software handling a 
Relational database is called Relational database management system or RDBMS.  Microsoft 
Access, MySQL, etc. are examples of RDBMS.

	 3.	 i.	 �Tables: A table is the basic element of a database.  it refers to a storage container storing 
data pertaining to a single object,  subject or purpose. A table stores data in the form 
of records(rows) and fields(columns). For example, an Employee table may contain all 
information pertaining to an employee e.g. employee ID, employee name, designation, 
department, grade etc.

		  ii.	� Fields: A field, also known as a column or attribute, is the smallest unit of data in a database 
table. Fields represent specific types of information about the entities or objects being 
stored in the table. Each field has a name and a data type that defines the kind of data 
it can hold (e.g., text, number, date). For example,  name, age, address, and designation 
can be the fields in a given table employee.

		  iii.	 �Records: A record, also known as row or tuple, is a collection of multiple data values 
related to a particular entity.

	 	 For Example, Mr. John ,43 years, Noida, Marketing manager can be treated as a record.
	 4.	 A form is an interface in a user-specified layout that lets user’s view, enter, and modify data 

directly in the table. Using forms, different database operations can be performed without 
writing queries.

	 5.	 The different type of data models are:
	 	 •	 �Hierarchical data model: This model organises data in a tree-like structure like a family 

tree. At the top is a single parent node and beneath it are Child nodes, which can further 
have their children.

8.
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	 	 •	 �Network Data model: This data model allows multiple records to be linked to a central 
master file.  It offers greater flexibility in data organization but can also present challenges 
in management compared to simpler models.

	 	 •	 �Relational data model: This data model is built on the concept of establishing relationships 
between two or more tables within the same database.  It is the most widely used database 
model.  In this model, data is organised into tables which consist of rows and columns. 
Each row represents a record whereas columns represent specific attribute or field.

B. 	 i.	 A database management system is a software package with computer programs that control 
the creation, maintenance and use of a database. It allows organizations to conveniently 
develop databases for various applications.

	 ii.	 Two database programs are:
		  a.	 Microsoft Access 
	 	 b.	 LibreOffice Base
	 iii.	 Id can be set as a primary key
	 iv.	 No. If there are more than one field is consider as primary key, then there will be two identities 

against a row. But, there can be only one identity against a row. So, we cannot have more 
than one primary key.

	Starting with LibreOffice Base�
Unit 3: Database Management System Using Libreoffice Base

Lab Assignment ‘n Activity Page 328-337

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 iii	 2.	 ii	 3.	 iv	 4.	 ii	 5.	 iv
B. 	 1.	 True	 2.	 False	 3.	 True	 4.	 True	 5.	 True
C. 	 i.	 Both A and R are true and R is the correct explanation of A.

Section B (Subjective Type Questions)
A. 	 1.	 In LibreOffice Base, a default value of a field refers to those predefined value that is 

automatically inserted into a field whenever a new record is created in a table.

	 2.	 CHAR VARCHAR

•	 �The character data type stores data with 
a fixed length as specified by the user.

•	 �The Varchar data types stores data up 
to a specified length.

•	 �It is ideal for entries that require a fixed 
number of characters.

•	 �The number of bytes allocated depends 
on the actual number of characters 
entered.

9.
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	 3.	 Steps to set a primary key:
		  Step 1:	 Position the mouse pointer on the field which you want to set as the primary key.
		  Step2:	 Right click on the field, a context menu appears.
		  Step 3:	 �Select the Primary Key option from the context menu. A key like symbol appears 

beside the column name denoting it as a primary key.
	 4.	 Steps to create a table in design view are given below:
		  Step 1:	 �Click on the Create Table in a Design View option from the Tasks pane. The Table 

Design window opens, which contains Field Name, Field Type, Description, and Field 
Properties.

		  Step 2:	 Type a name for the field in the Field Name column.
		  Step 3:	 Select the data type from the drop-down list in the Field Type column.
		  Step 4:	 Mention the details of the field in the Description column.
		  Step 5:	 Position the mouse pointer on the field which you want to be set as Primary key.
		  Step 6:	 Right-click the field. A context menu appears.
		  Step 7:	 Select the Primary Key option from the context menu.
		  Step 8:	 Click on the Save button in the Standard toolbar.
		  Step 9:	 Type the name of the table in the Table Name text box.
		  Step 10:	Click on the OK button. A table with the given name is created.
	 5.	 The five main components of a LibreOffice Base interface window are:
	 	 •	 �Title bar: Title bar lies at the uppermost side of the opening screen.  It displays the file 

name along with the maximize, minimize  and close button on the right side.
	 	 •	 �Menu bar: Menu bar contains the buttons of various menus like File,  Edit,  View etc.  that 

helps while working with the LibreOffice base.
	 	 •	 �Standard toolbar: It contains the shortcut buttons or icons for frequently used commands 

like New, Open, Save etc.
	 	 •	 �Database Pane: It provides a structured view of the essential components such as Tables, 

Queries, Forms and Reports.
	 	 •	 �Tasks Pane: The Task Pane is a box on the upper side named as ‘Tasks’. It contains three 

options to create a table.
	 	 •	 Status bar: It displays information about the current status of the opened application.
B. 	 i.	 ProductID can be assigned as the primary key of the given table as it contains a unique value 

for each record.
	 ii.	 Step 1:	 Open the table by double clicking on its name in the Tables pane.
				    The Product inventory table opens in the Table Data View window.
		  Step 2:	 Click on the Category field of the record where ProductName is Samsung 55” TV.
		  Step 3:	 Make the changes from Computers to Electronics.
		  Step 4:	 Click on the Save current record button from Table Data toolbar.
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	Working with Multiple Tables�
Unit 3: Database Management System Using Libreoffice Base

Lab Assignment ‘n Activity Page 350

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 i	 2.	 ii	 3.	 iii	 4.	 iii
B. 	 1.	 False	 2.	 False	 3.	 False	 4.	 True
C. 	 iii.	 A is true but R is false.

Section B (Subjective Type Questions)
A. 	 1.	 i.	 Right-click on the table that is to be deleted.
	 	 ii.	 �Select the Delete option from the context menu. A confirm Delete message box will 

open that prompts you to delete the table.
	 	 iii.	Click on the Yes button to delete the table.
	 2.	 A many-to-many relationship is a type of relationship between two tables where multiple 

records in one table are linked to multiple records in another table. 
	 	 �Example, Suppose we have two different tables CUSTOMERS and PRODUCTS 
		  Customers can buy multiple products and products can be bought by multiple customers.
	 3.	 Steps to rename a table in LibreOffice Base:
		  Step 1:	 Right-click on the table from the Tables pane.
		  Step 2:	 Select the Rename option from the context menu.

			   The Rename to dialog box opens.
		  Step 3:	 Type the new name for the table in the Table name text box.
		  Step 4:	 Click on the Ok button to rename the table.
	 4.	 LibreOffice Base provides four options to maintain referential integrity:
	 	 •	 �Update Cascade: It enables updates or deletions in the master table and automatically 

updates or deletes related records in transaction table also.
	 	 •	 Set NULL: Assigns null value to the related records if master record is updated or deleted.
	 	 •	 �No Action: It prevents updation or deletion of records in the master table if related 

records exist in the Child table.
	 	 •	 �Set default: Assigns a fixed default value to related fields if the master record is updated 

or deleted. 

10.



33Touchpad IT-402 (Ver. 4.0)-X (Answer Key)

B. 	 i.	 One to many relationship between Books and Loans because one book is borrowed by more 
than one member.

	 ii.	 One to many relationship between Members and Loans because one member is having one 
record in the Loans table.

	Queries in Base�
Unit 3: Database Management System Using Libreoffice Base

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 ii	 2.	 ii	 3.	 iii	 4.	 ii	 5.	 i
B. 	 1.	 False	 2.	 False	 3.	 False	 4.	 True	 5.	 False
C.	 1.	 ii.  Both A and R are true but R is not the correct explanation of A.
	 2.	 iii. A is true but R is false.

Section B (Subjective Type Questions)
A. 	 1.	 A query is a tool through which data is accessed or manipulated in a table.
	 2.	 SQL stands for structured query language which is store and manipulate data in a database. 

Different SQL commands are used to create and perform operations on relational databases 
such as creation, display, updation, etc.

	 3.	 The * wildcard character represents one or more characters whereas ?  Wildcard character 
represents only one character.

	 4.	 LibreOffice Base allows the user to categorise the data on this field. This field on the basis 
of which data is being grouped is called group-field.

	 5.	 To perform calculations in a query, we need to do the following:
		  Step 1:	 Go to the Queries section in the Database Pane.
		  Step 2:	 Click on Create Query in Design View option under the Tasks pane.
		  Step 3:	 Select the tables to which the query is related.
		  Step 4:	 Click on Add button and then click on Close button the table selection window.
		  Step 5:	 Drag and drop the required fields into the query grid.
		  Step 6:	 In a new column under the Field row, enter the formula for calculation.
		  Step 7:	 Give an alias name for the field displaying calculation
		  Step 8:	 Click on the Run Query icon and then save the query.
B. 	 1.	 i.   Select Sale_Id, Price from Sales where Discount>1000;
	 	 ii.  Select * from Sales Order By prod_Name;
	 	 iii. SELECT Prod_Name, (Price - Discount) AS Sales_Price FROM Sales;

11.
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	 2.	 i.   SELECT Scholarship + 1000 AS New_Salary FROM Student;
	 	 ii.  SELECT Roll_No, Scholarship - 500 AS Reduced_Salary FROM Student;
	 	 iii. SELECT First_Name, Last_Name, Scholarship * 3 AS Tripled_Salary FROM Student;
	 	 iv. SELECT Roll_No, First_Name, Last_Name FROM Student;

	Forms and Reports�
Unit 3: Database Management System Using Libreoffice Base

Lab Assignment ‘n Activity Page 379

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 ii	 2.	 i	 3.	 iii	 4.	 iv	 5.	 i
B. 	 1.	 False	 2.	 False	 3.	 False	 4.	 True	 5.	 True
C. 	 iii.	 A is true but R is false.

Section B (Subjective Type Questions)
A. 	 1.	 Form is the database object that provides a user-friendly interface to enter, modify and 

view data in a visually appealing and readable way. It acts as a front end for data entry and 
modification displaying data in a customized format rather than in row column format.

	 2.	 A static report displays the data present in the table but if changes are made in the table, 
those changes are not updated once a static report is created it whereas in a dynamic report 
changes done in a table will be automatically reflected.

	 3.	 Following are the steps to create form using Wizard:
		  Step 1:	 Click on the Forms object from the Database pane.
		  Step 2:	 Click on the Use Wizard to Create Report option in the Tasks Pane.
		  Step 3:	 �Select the ACCESSORIES table from Tables and queries drop-down list for which 

the form will be created.
		  Step 4:	� Add the fields to the Fields in the form list box from the Available fields list box 

by clicking on the > button to add the selected field or >> button to add all fields. 
We have added all the fields.

		  Step 5:	 Click on Next button to continue.
		  Step 6:	 �Label the fields by which they will appear on the report if desired and click on 

Next button.
		  Step 7:	 If you want to group data by a specific field, select it.
		  Step 8:	 Click on Next button if grouping is not needed.

12.
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		  Step 9:	 �Select the fields on the basis of which sorting will be applied in the records if 
desired.

		  Step 10:	 Click on Next button to proceed.
		  Step 11:	 Select a layout (e.g., columnar, tabular) and Orientation for the report.
		  Step 12:	 Click on Next button to continue.
		  Step 13:	 �Give a name to the report and specify the kind of report i.e. Static or Dynamic. 

Choose whether to modify the report layout or create it immediately.
		  Step 14:	 Click on Finish button to generate the report.
	 4.	 Following are the two ways of creating reports in LibreOffice Base:
	 	 •	 Create Report in Design View.
	 	 •	 Use Wizard to Create a Report.
	 5.	 The form navigation toolbar includes different navigation buttons that allow us to move 

through and view records in the form. As we navigate between records, the record number 
displayed in the text boxes changes accordingly.

		  The description of the five buttons available in the form navigation toolbars are as follows:
		  a.	 Find record: Search a specific record in the table.
		  b.	 First record: Show the first record on the form.
		  c.	 Save record: Save the new record in the table.
		  d.	 Refresh: Reload data in the form from the underlying database.
		  e.	 Sort: Sort data in ascending or descending order. 
B. 	 1.	 Dynamic
	 2.	 Use the Sort tool in the form view on the basis of the field “Publication Year” in ascending 

order.

	Health, Safety and Security at Workplace�
Unit 4: Maintain Healthy, Safe and Secure Working Environment

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 iv	 2.	 ii	 3.	 ii	 4.	 ii	 5.	 iii
B. 	 1.	 Chemical	 2.	 Mental	 3.	 hazard control			   4.	 training	 5.	 Psychosocial
C. 	 1.	 i.  Both A and R are true and R is the correct explanation of A.
	 2.	 ii. Both A and R are true but R is not the correct explanation of A.

13.
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Section B (Subjective Type Questions)
A. 	 1.	 Workplace safety involves the aspect of essential safety practices and proactive identification 

of potential hazards. It refers to the policies, procedures, and practices followed in order to 
protect employees from hazards, injuries, and health risks involved in workplace.

		  Importance of Workplace Safety
	 	 •	 To reduce workplace accidents, protecting employees from harm.
	 	 •	 To provide a safe work environment having few disruptions.
	 	 •	 �To minimize medical expenses, legal fees, and compensation claims due to workplace 

incidents.
	 	 •	 It helps businesses follow health and safety laws, avoiding fines and penalties.
	 	 •	 People feel safe in a good work environment and their performance improves.
	 2.	 A hazard is anything that has the potential to cause harm, injury, or damage to people, 

property, or the environment.
		  Risk is the possibility that a hazard cause a potential harm.
	 3.	 Following are the three types of workplace hazards:
		  Mechanical hazards are those that arise from machinery or equipment with moving parts, 

sharp edges or  rotating components that can cause crushing or other severe entanglement 
injuries.

		  Biological hazards are those type of hazards that are generally  found in healthcare sector, 
laboratories or environments handling organic matter that  includes exposure to bacteria, 
viruses, fungi and various parasites , It can causes infections or illness.

		  Electrical hazards are those kind of hazards that are caused due to  exposed electrical parts, 
faulty wiring, improper  use of electrical appliances. It can cause electric shocks , burns and 
fire hazards.

	 4.	 Regular training should be given in workplace in form of mock drills so that people are well 
aware of the safety facilities available at workplace. It enhances the effectiveness of safety 
measures by protecting the employees and promoting operation efficiency and overall well-
being.

	 5.	 Following are the responsibilities of a workplace health and safety committee:
	 	 •	 �It provides sufficient resources to support ongoing improvement in occupational health 

and safety performance.
	 	 •	 It implement measures and processes to prevent occupational accidents, injuries, etc.
B. 	 i.	 �The key mistake made by the company is not faming a safety committee that could address 

the hazards.
	 ii.	 Following actions can be taken to ensure workplace safety:
	 	 •	 �Modifying equipment or processes to reduce the risk of exposure to hazards such as 

installation of ventilations system to remove airborne contaminants.
	 	 •	 �By removing hazardous materials directly from the workplace or by replacing them with 

something safer.
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	Workplace Quality Measures�
Unit 4: Maintain Healthy, Safe and Secure Working Environment

Lab Assignment ‘n Activity Page 426 

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions) 

A. 	 1.	 ii	 2.	 i	 3.	 i	 4.	 ii	 5.	 ii
B. 	 1.	 air quality	 2.	 chair	 3.	 OOS(Occupational Overuse Syndrome)
	 4.	 20-20-20, 20
C. 	 i.	 Both A and R are true and R is the correct explanation of A.

Section B (Subjective Type Questions)
A. 	 1.	 Monitoring of water quality is important to find details of key parameters  related to water 

such as pH value, contaminants present in the water such as bacteria, heavy metals, etc. 
Results of the monitoring can be used to determine the water quality and to find whether any 
contamination issues are present or not. It is important for maintaining a safe environment 
and protecting public health

	 2.	 One can avoid musculoskeletal problems associated with prolonged computer used by 
taking few precautions such as:

	 	 •	 �Follow the 20-20-20 rule that is in every 20 minutes look at something which is 20 feet 
away for at least 20 seconds to give rest to your eyes.

	 	 •	 �Use an ergonomic keyboard and mouse that promote a natural wrist position and minimise 
strain.

	 	 •	 �Incorporate streching exercises for your neck, shoulder , wrists and back in your daily 
routine.

	 3.	 Eye strain is a condition that is cause due to focusing on screens for long duration 
continuously. It leads to tired eyes. Various symptoms of eye strain includes dryness, blurry 
vision, headaches and discomfort in the neck or shoulder.

		  Following are the causes of eye strain:
	 	 •	 Improper lighting
	 	 •	 Incorrect viewing distance
	 	 •	 Uncorrected vision issues
	 4.	 It is important to use ergonomic chairs and desks in an office to prevent oneself specially 

people who have to work on computers for long durations from musculoskeletal problems 
such as hand discomfort, neck and shoulder pain, lower back pain, muscle fatigue, etc. The 
use of ergonomic chair provides good lumber support and usage of ergonomic keyboard 
and mouse provides comfort in working and puts less strain on wrists.

14.
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	 5.	 Following are the factors that contribute to occupational overuse syndrome:
	 	 •	 Repetitive movements
	 	 •	 Awkward postures
	 	 •	 Putting excessive strain in occupational activities
B. 	 Few measures can be taken such as:
	 •	 She should take regular breaks after every 20 minutes.
	 •	 She should ensure that her workplace is spacious enough to accommodate things as well 

as it should be arranged time to time.
	 •	 Her workplace should be well lighted.

	Prevent Accidents and Emergencies�
Unit 4: Maintain Healthy, Safe and Secure Working Environment

Lab Assignment ‘n Activity Page 436

Do it yourself.

Unsolved Exercise 
Section A (Objective Type Questions)

A. 	 1.	 iii	 2.	 iii	 3.	 iv	 4.	 ii
B. 	 1.	 False	 2.	 True	 3.	 True	 4.	 False	 5.	 True
C. 	 i.	 Both A and R are true and R is the correct explanation of A.

Section B (Subjective Type Questions)
A. 	 1.	 Healthy living means making daily choices that prioritise physical, mental, and emotional 

well-being. This includes regular exercise, a balanced diet rich in nutrients, managing stress 
effectively, and ensuring adequate sleep.

	 2.	 Following are some common electrical based risk causing factors:
	 	 •	 Damaged extension cords or damaged electronic appliances
	 	 •	 Blocked electrical panels and heaters
	 	 •	 Overloaded circuits
	 	 •	 Thundering and lightening
	 	 •	 Loose connections
	 	 •	 Old or poor wiring
	 	 •	 Presence of inflammable substance near electronic equipments
	 3.	 Following measures can be taken to prevent accidents due to moving objects:
	 	 •	 Adequate lighting should be at such kind of workplace so that the visibility is clear.
	 	 •	 Standard procedures should be followed to handle those objects.
	 	 •	 Proper safety equipment should be used by workers.

15.
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	 4.	 Importance of evacuation policy in an organization is to keep people safe during dangerous 
or potential hazardous situation to ensure a safe environment. It enables employees to have 
a clear plan regarding the proper evacuation plan.

	 5.	 As soon as you encounter a person having electrical shock follow these measures:
	 	 •	 Turn off the electrical power and unplug the electrical appliances.
	 	 •	 Don't touch the injured person if he/she is still in contact with the source.
	 	 •	 Use non- conducting dry object such as plastic or wood to remove the source.
	 	 •	 Avoid touching the victim or any conducting surface while they remain energized.
	 	 •	 Deactivate electrical circuit to eliminate the hazard. 
	 	 •	 Try to arrange for immediate medical attention for the victim.
B. 	 As a safety leader, I would follow few basic measures to train my classmates such as:
	 •	 Train my classmates about the essential first aid skills, such as treating cuts, burns, and 

fractures and follow the standard operating procedures followed in case of some common 
accidents.

	 •	 Notify them about the emergency and ways to report incidents. Maintain clear and open 
communication with emergency responders.

	 •	 Fire and emergency evacuation drills should be conducted on regular basis to familiarise 
classmates with escape routes.

	 •	 Educate them on identifying potential risks present in the environment.
	 •	 Simulate emergency situations to prepare them for such situations.
	 •	 Train them to stay calm and follow instructions.
	 •	 Ask them to keep essential safety equipments such as fire extinguishers in a proper working 

condition and easily accessible.


